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RidomTraceEdit User Guide

1.Introduction
Ridom TraceEdit  is  a  cross-platform graphical  DNA trace  viewer  and editor.   TraceEdit 
displays the chromatogram files from Applied Biosystems automated sequencers and files in 
the Staden SCF format. Incorrect base calls can be edited and saved. TraceEdit is designed to 
operate on Windows, MacOS X and UNIX platforms.

DNA sequencing has been the standard against which other types of DNA testing is compared. 
Major advances in DNA sequencing include the development of automated sequencers, discovery 
of  fluorescent  terminator  chemistry,  and  cycle  sequencing.  These  developments  have  made 
sequencing easier  to perform and therefore more widely used.  Currently,  sequencing is used to 
identify microbial drug resistance mutations, cancer predisposition, somatic mutations, and genetic 
diseases. With the sequencing of the human genome and the “new era of molecular medicine”, one 
can only expect the use of DNA sequencing to increase. Therefore, an increasing number of people 
need to check the evidence for individual DNA sequences by inspecting the chromatograms (more 
commonly known as trace files) from which the base calls were deduced. Trace files are stored in 
proprietary formats, such as those of ABI, or public formats such as SCF.

Ridom TraceEdit can read ABI and SCF trace files and displays their contents. The program can be 
used to locate and delete the extent of low quality data at both ends of the sequence (trimming by 
Ns or low base quality values if available). It also enables the user to edit the base calls and to save 
them in SCF file format. A typical display from TraceEdit is shown in Figure 1. It includes the 
name and additional information of the sequence being inspected, the menu bar, the file list pane 
with tool bar, and the trace editor pane with tool bar. In the file list pane a trace file can be chosen 
to be displayed in the editor pane. The trace editor pane shows the trace data, the quality values (if 
available), the original sequence, the edited sequence, and the base positions. The extent of poor 
quality data at the left of the reading is denoted by gray shading. A separate text window (not 
shown) is used to display the textual data contained in the file.

The trace data can be scrolled using the scrollbar beneath the trace editor pane. The trace can be 
magnified  in  horizontal  and  vertical  directions.  The  original  sequence  and  the  quality  values 
(different formats are available) can either be switched on or off. It is possible to open several traces 
at once and shortcuts allow for quick navigation between traces. TraceEdit produces PDF files of 
the traces or sends them directly to the printer. Incorrect base calls selected using the mouse can be 
changed or deleted accordingly. Holding down the Backspace or Delete keys will rapidly delete 
successive bases, backwards for Backspace and forwards for Delete. To insert a base, the user must 
click between the bases with the right mouse-button. Once a base is selected, it is possible to scroll 
through the sequence using the left and right keyboard button (for further shortcuts it is referred to 
the Quick Reference section). The user can define, store, and search for nucleotide patterns that 
may include regular expressions. The edited sequence can be copied to the clipboard or exported to 
a file. Alternatively, a NCBI BLAST search may be initiated with the edited sequence directly from 
TraceEdit. Sequences from the NCBI nucleotide database can be directly imported into the software 
by stating the database accession numbers. The software behavior may be user defined in several 
aspects by the preferences menu option.

TraceEdit  includes  a  feedback  dialog  to  provide  the  user  with  a  convenient  way  of  sending 
messages such as feature requests and bug reports directly to the developers. Finally, a download 
option for online-updates is integrated into the software.
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2.Features

• Operate on Windows, Mac OS X, and Linux operating systems

• View ABI and SCF chromatogram files

• Open at once several chromatogram files or whole directories

• Sort file list by different predefined options

• Navigate file list by keyboard shortcuts

• Scale the trace peak size vertically and horizontally

• Scroll a trace to a desired position

• Select bases from the trace

• Search for sequences using regular expressions

• Display or hide original base calls

• Display or hide quality values, if included in the chromatogram file

• Display as text other chromatogram information contained in the file

• Display as text the DNA sequence of your chromatogram

• Display the reverse complement of a trace

• Mark or unmark bases of interest (low quality, ambiguities)

• Import sequences from NCBI nucleotide database by accession numbers

• Print a trace

• Produce a PDF of a trace

• Copy, paste, and edit sequences

• Use contextual menus to copy, paste, and edit

• Trim sequence ends by Ns or low base quality values

• Save traces in SCF format

• Export base calls as a FASTA sequence

• Initiate a BLAST search from edited sequence

• Communicate directly from within the software with the developers for bug reports and feature 
requests

• Update the software automatically online
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3.Installing Ridom TraceEdit

System Requirements

• An installed Java Runtime Environment 1.5 or higher is required to run Ridom TraceEdit. Java is 
freely available from www.java.com 

• An installed  PDF Viewer  (e.g.,  Adobe Reader,  www.adobe.com) is  needed  for  viewing the 
manual and to use the “Print to PDF” feature

• The MS Windows version was tested on NT4.0, 2000 and XP with Java 1.5

• The MacOS X version was tested on 10.4 with Java 1.5

• The Linux version was tested with Java 1.5

Supported File Formats

Readable Formats

• SCF (v2.0, 3.0, 3.1) from ALF, Li-Cor, Visible Genetics OpenGene, Beckman CEQ 2000XL 
and CEQ 8000, and other sequencers; SCF with qualities from Phred and Ridom Tracer; ABIF 
from Applied Biosystems sequencers

• Import of consensus and chromatograms from RSX files (Ridom TraceEditPro file format)

• GenBank files

• FASTA; plain text files

Writable Formats

• SCF 3.0: An open binary file format for chromatogram sequences. In addition to the standard 
SCF,  Ridom TraceEdit  writes  the  original  base-calls  in  a  SCF-conform user  block with the 
magic number 0x6f726263.

• FASTA: A text file format for base sequences. A sequence block consists of a comment line 
headed by “>” and several data lines with sequence bases.

Installing Instructions

• Download from www.ridom.de the newest version of Ridom TraceEdit

• Double click the downloaded file and follow the on-screen instructions (please remember, you 
have to install Java first before you are able to install Ridom TraceEdit)

• Ridom TraceEdit can now be started by clicking the software's icon (in the installed directory, on 
the desktop or in the Start Menu)

Updating the Software

A download option for online-updates is integrated into the software (Help menu).

Ridom TraceEdit Help

Use the  button in the Help menu to view this PDF-document (the document includes a Quick 
Reference with menu, tool bar functions and keyboard shortcuts).
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4.Getting Started

Keyboard Shortcuts

Frequent occurring actions can be conveniently invoked by keyboard shortcuts (Mac OS X: use ^ 
instead of Ctrl, to pop-up right-mouse-button menus under Mac OS X with a single button mouse, 
press Ctrl and the single mouse button). All menu commands can also be invoked (e.g., if no mouse 
is available) by using the Alt key in combination with a character as indicated by underscore in the 
menu (e.g., for the command “Open...” press Alt+F, P).

Main Window

Use drag and drop, the  button or the Open... function in the File menu to open a sequence file.

The main window (Figure 1) contains a list of sequence files on the left (the file list pane with tool 
bar), and the editor on the right (the editor pane with its own tool bar) shows the currently opened 
sequence. The icon left of the files shows the sequence type (text or chromatogram). The bullets in 
the lower left corner of the  icon represent the status of the sequence ( yellow = opened,  red = 
opened and edited,  green = saved). If the sequence was reverse complemented, the icon contains 
an arrow ( ) in the upper right corner.

Double-click on a file in the file list pane to open its sequence in the editor pane. Click on the 
Position label in the status bar, to jump to a specific base number.

Use the File menu function  Add Files/Directories... to scan a whole directory subtree and to add 
all sequence files that are found to the list.
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Info Window

Use the  button in the editor tool bar to display textual data contained in the sequence file. The 
opening  window  contains  textual  data  about  the  particular  sequencing  experiment  such  as  its 
chemistry,  machine  type  and operating  conditions  etc.  In addition  are  the  sequence  length,  the 
number of ambiguities, the Q20, the Q20 ratio and the MBQ from the edited sequence shown. The 
Q20 defines the number of bases with a quality of >=20 (the Q20ratio gives the ratio of Q20 to the 
total number of bases and the MBQ gives the mean base quality).

Find Dialog

Use the Find... function in the Edit menu to search for strings in the 
sequence.  The  appearing  Find  dialog  (Figure  2)  offers  two  search 
modes:

• Find Pattern can be used to quickly search for a nucleotide pattern. 
The  pattern  may  include  regular  expressions  (see  below).  -  By 
default, entered ambiguities are resolved during the search, i.e. an 
'N'  matches  to  bases  'A',  'C',  'G',  'T'  or  'N'.  If  you want  that  an 
ambiguity  matches  exclusively  only  to  its  own  letter  (i.e.  'N' 
matches only 'N'), uncheck the Resolve ambiguities box.

• Find Predefined Pattern can be used to manage a list of often used 
search patterns. The pattern may also include regular expressions 
(see below). Ambiguities are always resolved (use the OR option to 
combine different patterns).

Search Near Match can be enabled, to perform an alignment to find the nearest match, if an exact 
match was not found. All found matching positions are highlighted in the editor.

Regular Expressions

The sequence search supports the following regular expressions:

• ? matches the preceding expression or the null string
(e.g:  “AC?G” - matches  “AG”, and “ACG”)

• * matches the null string or any number of repetitions of the preceding expression 
(e.g:  “AC*G” - matches  “AG”, “ACG”, “ACCG”, “ACCCG”, and so on)

• + matches one or more repetitions of the preceding expression
(e.g:  “AC+G” - matches  “ACG”, “ACCG”, “ACCCG”, “ACCCCG”, and so on)

• {m} matches exactly m repetitions of the preceding expression
(e.g:  “AC{3}G” - matches  “ACCCG”)

• {m,n} matches between m and n repetitions of the preceding expression, inclusive
(e.g:  “AC{2,4}G” - matches  “ACCG”, “ACCCG”, and  “ACCCCG”)

• {m,} matches m or more repetitions of the preceding expression
(e.g:  “AC{2,}G” - matches  “ACCG”, “ACCCG”, “ACCCCG”, and so on)

• a|b matches whatever the expression a would match, or whatever the expression b would match
(e.g:  “ACG|CAA” - matches  “ACG”,  and  “CAA”)

• (abc) can be used for grouping expressions in combination with the operators above
(e.g:  “A(CAT)?G” - matches  “AG” and “ACATG”)

Ambiguities are resolved by default, 'X' is treated like the ambiguity 'N'. Space characters are ignored.  
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NCBI Nucleotide Blast Search 

Starts a NCBI BLAST search with the currently opened DNA sequence. The query page of the 
NCBI GenBank server is opened in your default WWW browser with the sequence already pasted 
into the form.

Import Sequence from NCBI Nucleotide DB

This  menu option can be used to import  sequences  from the NCBI nucleotide  database.  These 
sequences  are  imported  with  associated  parameter  templates,  that  means  sequences  can  be 
immediately cropped. The sequences are stored as assemblies and the associated report will contain 
the whole NCBI entry. To address the sequences the NCBI accession number must be stated. It is 
possible to address several sequences at once and to import the sequences in a batch process (e.g., 
AY688029-AY688031;  AY688035  will  result  in  the  import  of  the  sequences  AY688029, 
AY688030, AY688031, and AY688035).

Send Bug Report

Ridom TraceEdit includes a feedback dialog to provide the user with a convenient way of sending 
messages directly to the developers such as features requests and bug reports. This dialog can be 
opened in the Help menu.

If an internal error occurs, this dialog window opens automatically. The report already contains the 
internal  description  of  the  error  that  occurred  together  with  some  system  information  (Ridom 
TraceEdit version, OS and Java version). If the error occurred after a specific user transaction it 
would be of help to us in solving the problem, if a description of the circumstances leading to the 
problem is given in the comment field. Inserting the software's error log in this field is achieved by 
clicking the right mouse-key and choosing the corresponding menu entry.
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5.Configuration
Use the function  Preferences...  in the  Options menu to open the configuration window with the 
following four tabs:

Editor Tab

Configures the display style of the sequence editor. 

Default base editing quality Defines  the  default  quality  that  will  be  used  when  a  base  is 
substituted or inserted

Default quality, if no qual. available Defines a default quality for FASTA sequences

Show qualities as numbers Quality values will be displayed in a box below the base

Show qualities as bars Quality are displayed through the length of a bar below the base

Use gray (gradient) colors The  quality  value  is  visualized  through  the  gray  shading  of  the 
box/bar, ascending from light gray to dark gray

Use threshold colors The quality value is visualized by the defined threshold colors.

The thresholds can be edited in the colored slider below:

• drag the thresholds with the left mouse button

• double-click to change the color

• right-click to add or remove thresholds

Show base call center lines Show/hide the vertical line on a base-call position  

Show base qualities Show/hide the qualities of the bases (if available) 

Show original bases Show/hide the original bases above the edited ones

Trimming Tab

Ridom TraceEdit can detect unreliable 5' and/or 3' ends (by Ns or low base quality values) when 
opening a sequence. These regions are marked by writing the bases in gray color. Use the Auto-trim 
button  in the sequence editor, to cut off these unreliable regions. 

Dialogs Tab

This tab contains an option to disable the confirmation dialog when exiting or closing unsaved 
chromatograms. In addition, it can be defined here whether the assembly icons of RSX files should 
be shown in the file open dialog (RSX assembly files are created by TraceEditPro).

Updates Tab

By default the search for software updates during program start is enabled in this tab. If a proxy 
server is necessary to access the Internet, the parameters can be configured here.
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6.Quick Reference

Keyboard Shortcuts

Frequent occurring actions can be conveniently invoked by keyboard shortcuts (Mac OS X: use ^ 
instead of Ctrl, to pop-up right-mouse-button menus under Mac OS X with a single button mouse, 
press Ctrl and the single mouse button). All menu commands can also be invoked (e.g., if no mouse 
is available) by using the Alt key in combination with a character as indicated by underscore in the 
menu (e.g., for the command “Open...” press Alt+F, P).

File List Functions
Icon Shortcut Description

Ctrl+O Opens sequence files (SCF, ABI, FASTA, GenBank or plain text)

Ctrl+S Saves the opened sequence to a file  (SCF or FASTA format)

Ctrl+P Prints the opened sequence chromatogram

Ctrl+F8 Closes files that are currently selected in the list

Sorts the files in the list by edit state, name or file path

F10 Opens the previous file in the list

F9 Opens the next file in the list

F8 Closes the currently opened file

Tab Toggles the focus between the file list and the sequence editor

Sequence Editor Functions
Icon Shortcut Description

Ctrl+Z Undoes the last editing step(s)

Ctrl+Shift+Z Redoes the last editing step(s) 

Resets to original base-calls 

Ctr+Alt+Home Deletes all bases left to the selected base

Ctrl+Alt+End Deletes all bases right to the selected base

Ctrl+T Automatically trims the sequence by cutting off the unreliable 5'/3' regions that are marked by gray colored 
base characters

Zooms in/out chromatograms

Ctrl+Shift+A Marks/Unmarks ambiguity bases in the consensus

Ctrl+Shift+Q Marks/Unmarks low quality bases in the consensus

! Marks/Unmarks current position in the consensus

Ctrl+Left Moves the cursor to the next ambiguity (low quality base) on the left

Ctrl+Right Moves the cursor to the next ambiguity (low quality base) on the right

Ctrl+F Searches a pattern in the consensus

Removes found pattern marks

Ctrl+I Shows the sequence textual comments

Left / Right Moves the base-cursor one base left / right

Home / End Moves the base-cursor to first base / last base

Shift+Left / 
Shift+Right

Moves the base-cursor one block left / right

Ctrl+G Goes to a base by specifying its base number in the status bar

Tab Toggles the focus between the file list and the sequence editor
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Menu Functions
Menu Item Icon Shortcut Description

File

Open... Ctrl+O Opens sequence files (SCF, ABI, FASTA, GenBank, RSX, or plain text)

Add Files/Directories... Adds new sequence files to the file list. If  a directory was selected, the 
whole subtree is scanned for sequence files and all  sequence files are 
added to the list

New Sequence from Clipboard Reads sequence data from clipboard

Save As... Ctrl+S Saves the opened sequence to a file  (SCF or FASTA format)

Export... Ctrl+E Exports the opened sequence to a file (FASTA format)

Print... Ctr+P Prints the opened sequence chromatogram

Print to PDF... Prints the opened sequence chromatogram to a PDF file 

Close... Ctrl+F8 Closes all files that are currently selected in the list

Close Selected Files Ctrl+Alt+F8 Closes all files in the list

Exit Ctrl+Q The preferred way to exit the program

Edit

Find... Ctrl+F Searches for a pattern in the sequence (accepts ambiguities and  regular 
expressions). The found matches are highlighted in the editor.

Remove Find Marks Removes all  highlighted search result marks

Refresh Auto-trim Marks Refreshes the gray trim markings (e.g., after resetting the sequence to 
original base-calls)

Remove Auto-trim Marks Removes the gray trim markings

Substitute Base... A,C,G,T and 
R,Y,K,M,S,W,B
,D,H,V,N

Substitutes the selected base 

Delete Base Delete | 
Backspace 

Deletes the selected base (holding down the Backspace or Delete keys 
will rapidly delete successive bases, backwards for Backspace and 
forwards for Delete)

Insert Base... Insert Inserts a new base left to the selected base

Trim Left Ctrl+Alt+Home Deletes all bases left to the selected base

Trim Right Ctrl+Alt+End Deletes all bases right to the selected base

Cut by Auto-trim Ctrl+T Automatically trims the sequence by cutting off the unreliable 5'/3' regions 
that are marked by gray colored base characters

Copy Sequence to Clipboard Copies the currently opened sequence to clipboard

Reverse Complement Ctr+R Reverses and complements the sequence and the chromatogram

Options

NCBI Blast Search Ctrl+B Performs a similarity search at the  NCBI`s Blast site with the edited 
sequence (requires an Internet connection and an installed WWW 
browser)

Import Sequence from NCBI 
Nucleotide DB… 

Imports sequence(s) from the NCBI database via accession number(s)

Preferences... Configures the TraceEdit parameters (editor, trimming, dialogs, updates)

Help

TraceEdit Help F1 Opens the program manual PDF in an external viewer (e.g., Adobe 
Reader)

Ridom Home Page Opens the Ridom home page with the default WWW browser

Ridom TraceEditPro Opens  the  web  page  of  TraceEditPro,  a  commercial  sequence 
assembling and editing  software

Software Update Makes  available  two  sub-menues:   Online  Update:  searches  for 
available software updates at the Ridom web server and  Import Update 
File... : imports a software update file that was manually downloaded from 
the Ridom web server

Send Bug Report... Sends a bug report or a request of new feature 

About... Opens the Ridom TraceEdit version info (including a system overview)
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7.IUPAC Codes

Symbol Meaning Origin of designation

G G Guanine

A A Adenine

T T Thymine

C C Cytosine

R G or A puRine

Y T or C pYrimidine

M A or C aMino

K G or T Keto

S G or C Strong interaction (3 H bonds)

W A or T Weak interaction (2 H bonds)

H A or C or T not-G, H follows G in the alphabet

B G or T or C not-A, B follows A

V G or C or A not-T (not-U), V follows U

D G or A or T not-C, D follows C

N G or A or T or C aNy
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8.Ridom TraceEdit Frequently Asked Questions (FAQ)

My chromatogram file format is not yet supported by Ridom TraceEdit!

This is possible. However, we always try to enhance the software's capabilities. Therefore, please 
send us a few sample files and tell us from which sequencing machine this files were derived and 
which collecting software was used. We will then try to incorporate an import filter with the next 
software update.

When I start Ridom TraceEdit, my firewall software tells me that the software tries  
to connect to the Internet!

Well,  you are  right.  However,  it  is  not  our software  but  the  Java virtual  machine  that  tries  to 
connect to the Internet to look for updates. We declare herewith that Ridom TraceEdit never tries to 
connect automatically to the Internet and that we by no means ever spy Ridom TraceEdit users. Of 
course, if you perform a BLAST search or search for software updates during program start (if 
enabled in the Preferences menu), Ridom TraceEdit connects to the Internet.

Why is Ridom TraceEdit for free available?

We are a bioinformatics company and we have to earn money to survive. Therefore, we produce 
also commercial software. However, we regard Ridom TraceEdit as a sort of marketing instrument 
and we hope that we can convince you with this free software that we are able to produce other 
quality software too (e.g., our sequence assembling editor TraceEditPro).

9.Ridom TraceEdit Version History
Ridom TraceEdit version 1.0 was released in February 2004.

Ridom TraceEdit version 1.1 was released in August 2005, with the following major improvements:

• support for automatic trimming,

• support for GenBank files and direct sequence import from NCBI, and

• extended support for SCF files.
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10.End User Licence Contract for Ridom TraceEdit

Permission is granted to anyone to use this software FREELY for any purpose, subject to the following restrictions:

I. General

a) This End User Licence Contract (EULC) forms a legally binding contract between you, the licensee, and Ridom 
GmbH, the licensor for the  Ridom TraceEdit software and related media, materials and documentation (the 
software product).

b) If you do not agree to these conditions, you are not entitled to use the software.
c) The person who concludes this EULC assures and makes warranty that he is entitled to declare a legally binding 

contract on behalf of his employer as the licensee.
d) The software product is licensed not given away.

II. Copyright

a) The  software  product  distributed  by  Ridom GmbH  is  protected  both  by  copyright  laws  and  international 
copyright treaties, and also by other laws and agreements concerning intellectual property.

b) Ownership  and  copyright  of  the  software  product  (including  but  not  restricted  to  images,  photographs, 
animations, video, audio, text and applets which are included in the software product), the accompanying printed 
material and each copy of the software product are the property of Ridom GmbH. All rights and intellectual 
property rights in and to content which can be accessed with the aid of this software product are the property of 
the respective owners of the content, and may be protected by applicable intellectual property rights laws and 
other laws and agreements on intellectual property. This EULC does not grant the licensee the right to use such 
content.

III. Scope of Licence

a) The licensee is entitled to install the software product, the demonstration-version or an earlier version on several 
computers, workstations, portable PCs or another digital electronic device.

b) The software product is licensed as a unitary product. The licensee is not entitled to separate its components for 
use.

c) The licensee is not entitled to reverse develop, to decompile or to disassemble the software product. No changes 
to the existing source code, neither any re-use of parts of it are permitted.

d) The licensee is not entitled to resell the software product or in any other way to transfer the software product for 
a counter-value. The licensee is not entitled to rent the software product, to lease it or to sell it.

e) Without prejudice to its other rights, Ridom GmbH is entitled to terminate this EULC insofar as the licensee 
contravenes the provisions of this EULC. In such a case, the licensee is obliged to destroy all copies of the 
software.

f) Ridom GmbH reserves all rights not expressly granted. The individual provisions of this licence agreement can 
only be changed by Ridom GmbH. The written form is required for this, without any exception.

IV. Warranty and assurances

a) This software is provided 'as-is', without any express or implied warranty. In no event will the Ridom GmbH be 
held liable for any damages (e.g., hardware damages, loss of data) or miscalculations arising from the use of this 
software.

b) The  software  product  is  supplied  in  accordance  with  the  current  development  status.  Ridom GmbH draws 
attention to the fact that is not possible in the current state of technology to create computer software such that it 
works without errors in all applications and combinations. The subject of this contract is therefore only software 
which is in principle usable in the sense of the program descriptions and user manual.

c) Statements contained in brochures, advertisements and similar documents represent only descriptions, and do 
not contain any assurance of properties or guarantees.

V. Limitation of liability

a) The licensee bears the responsibility for the selection and for the consequences of use of the software product, 
together with the results thereby intended or achieved.
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b) Liability for damages of any kind (included without restriction are damages from loss of profit, loss of business 
information or from any other financial loss) which arises as a result of the use of this product or of the inability 
to use this product is expressly excluded.

c) For damage or loss which involve death or physical injury, Ridom GmbH is in no case liable for aggravated 
compensation for damages or penalty compensation for damages, for any specific indirect, coincidental damage 
or loss or consequential loss or damage arising therefrom (this applies particularly, but not exclusively, for loss 
of use, loss of data, loss of profit and for loss of savings and business). This applies regardless of the basis of the 
claim or grievance.

d) Ridom GmbH is not responsible for and makes no warranty for the product running without interruption or 
without error.

VI. Place of judgement and applicable law

a) Place  of  fulfilment  for  all  obligations  arising  from the  contract  relationship  is,  for  both  contract  partners, 
Würzburg, the base of Ridom GmbH. This applies even if the residence of the customer is unknown or is outside 
Germany.

VII. Final provisions

a) Should any provision of this EULC be or become ineffective or contestable for any reason, its content is not 
otherwise disturbed thereby. Rather, it is to be performed in accordance with the intent.

b) Instead of the ineffective or contestable provision, an appropriate regulation is to apply which, as far as legally 
permissible, comes as close as possible to that which the parties who concluded the contract intended or would 
have intended in accordance with the sense and purpose of this contract if they had considered the point when 
concluding this contract. The same applies in the event of a lacuna in this contract. This also applies even if the 
ineffectiveness of a provision rests in any way on a measure of the performance and the time (period or date) 
prescribed in the contract. A legally permissible measure of the performance or time (date or period) which 
comes as close as possible to that which was intended shall then be deemed to be agreed.

           Ridom TraceEdit, license version 1.1 
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11.Ridom TraceEditPro Features
• DNA sequence assembling software for small and medium sized (re)sequencing projects (reads ABI-, SCF-

chromatograms and GenBank & FASTA files) 

• Flat learning curve by simple but powerful user interface 

• Quality values for each base pair and consensus sequence 

• (Semi)automated analysis of DNA sequence data allows for faster and more accurate results 

• Data visualization allows for focusing on relevant data only 

• Multiple frame protein translation with smart translation of ambiguous but non degenerated codons 

• Easy linkage for querying to Internet and local reference sequence libraries 

• Easy creation of local reference sequence libraries 

• Designed for pathogen (sub)typing, allele identification and sequence confirmation 

Interested?
Download a demo version,
request further information

or ask for an offer
http://www.ridom.de
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